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• Introduce the Zephyr Project

• Review High-level Software Features 

and Hardware Support

• Set up a Development Environment

• Hands-on: Build, Flash, and Debug an 

Application

Agenda
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Zephyr Project Introduction
What is the Zephyr Project? Why should I use it?



COMPANY PUBLIC 3

Zephyr Project 

• Open source real time operating system

• Vibrant Community participation

• Built with safety and security in mind

• Cross-architecture with growing developer 

tool support

• Vendor Neutral governance 

• Permissively licensed - Apache 2.0

• Complete, fully integrated, highly 

configurable, modular for flexibility, better 

than roll-your-own

• Product development ready with LTS

• Certification ready with Auditable

Open Source, RTOS, Connected, Embedded

Fits where Linux is too big

Zephyr OS

Kernel

OS Services

Application Services

HAL

3rd Party Libraries
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Fully featured OS allows developers to focus on the application

• Highly Configurable, Highly Modular

• Cooperative and Pre-emptive Threading

• Memory and Resources are typically 
statically allocated

• Integrated device driver interface

• Memory Protection: Stack overflow 
protection, Kernel object and device driver 
permission tracking, Thread isolation

• Bluetooth® Low Energy (BLE 4.2, 5.0) with 
both controller and host, BLE Mesh

• Native, fully featured and optimized 
networking stack
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NXP Board Support

• Kinetis Series (Cortex M4, M0+)
− FRDM-K64F

− FRDM-KW41Z

− FRDM-KL25Z

− TWR-KE18F

− Hexiwear

• LPC Series (Cortex M4, M0+, 
M33)
− LPCXpresso54114

− LPCXpresso55S69

(coming soon)

• i.MX RT Series (Cortex M7)
− RT1015 EVK

− RT1020 EVK

− RT1050 EVK

− RT1060 EVK

− RT1064 EVK

• i.MX 6/7 Series (Cortex M4 
subsystem)
− UDOO Neo Full

− Colibri iMX7

− WaRP7

https://docs.zephyrproject.org/latest/boards/index.html

https://docs.zephyrproject.org/latest/boards/index.html
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NXP Board Support

• Upstream

− Contributed and maintained by NXP and the community

− NXP active in upstream working groups

• Built upon MCUXpresso SDK

− SDK bare metal drivers and CMSIS device headers contributed upstream

− Shim drivers adapt SDK interfaces to Zephyr interfaces

− Maximizes code reuse

• Tested on hardware in NXP board farm
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Long Term Support (LTS) Release

• Product-focused release will receive bug fixes and maintain stable APIs for 
two years

• Extended stabilization period enabled more testing and bug fixing prior to 
release

• Baseline for auditable version of Zephyr

• Released in Apr 2019 (Zephyr v1.14.0)

• Supports over 160 board configurations across 8 architectures

• Contributions from 250 developers

• Hands-on exercises in this workshop use the LTS release
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Zephyr Project Governance

• Serves as the highest technical decision 

body consisting of project maintainers 

and voting members

• Sets technical direction for the project

• Coordinates X-community collaboration 
− Sets up new projects

− Coordinates releases

− Enforces development processes

− Moderates working groups

• Oversees relationships with other 

relevant projects

• Decides project goals

• Sets business , marketing and 
legal decisions

• Prioritizes investments and 
oversees budget

• Oversees marketing such as 
PR/AR, branding, others

• Identifies member requirements

• Code base open to all contributors,  
need not be a member to contribute.

• Path to committer and maintainer 
status through peer assessed merit 
of contributions and code reviews

• Ecosystem enablement

Governing 
Board

Financial & 
Policy 

Oversight

Marketing 
Oversight

Security

Oversight

Technical 
Steering 

Committee

Kernel & Subsystem 
Maintainers

Security 
Maintainer

Developer 
Tools 

Maintainers

Architecture 
Maintainers

Contributors

Individual 
Contributors

Others

Goal: Separate business decisions from meritocracy, technical decisions

Safety 
Oversight

Governing Board Technical Steering Committee Community

Member 
Organizations

Supporting 
Organizations
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February 2016 May  2019

and others….

Zephyr Project Membership



COMPANY PUBLIC 10

Zephyr Development Environment
What tools do I need? How do I install them on my PC?
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Development Environment Introduction
• Zephyr applications can be developed on Windows, Linux, or macOS host operating systems

• CMake and Python enable portability across host operating systems

• Detailed instructions are documented in the Getting Started Guide

• Major components:
− Python 3: Script interpreter and packages

− CMake/Ninja/Make: Build system

− Device Tree Compiler: Compiles device tree hardware descriptions

− Toolchain: gcc for Arm, RISC-V, x86, etc.

− Debug/Flash Tools: J-Link, pyOCD, OpenOCD, etc.

− West: Custom tool for repository management, build/flash/debug assistance, and image signing

− Zephyr Git repositories: The source code!

• Zephyr SDK provides toolchains and some debug/flash tools for Linux only

https://docs.zephyrproject.org/1.14.0/getting_started/index.html
https://github.com/zephyrproject-rtos/sdk-ng
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Windows: Command Prompt, WSL, or VM?
• Windows Command Prompt: Requires manual toolchain installation, but can use debug/flash tools like J-

Link and pyOCD. Recommended for new developers

• Windows Subsystem for Linux (WSL): Can use Zephyr SDK toolchains and sanitycheck, but does not 
support debug/flash tools like J-Link and pyOCD. Not recommended

• Linux Virtual Machine (VM): Can use Zephyr SDK toolchains, sanitycheck, and debug/flash tools like J-Link 
and pyOCD; but requires installing a virtual machine. Recommended for experienced developers
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Windows: Install Chocolatey and Packages

• Open an administrator command prompt

• Install Chocolatey package manager
− Similar to apt on Ubuntu

• Disable global confirmation
> choco feature enable -n allowGlobalConfirmation

• Use Chocolatey to install CMake
> choco install cmake --installargs 'ADD_CMAKE_TO_PATH=System'

• Use Chocolatey to install dependencies
> choco install git python ninja dtc-msys2 gperf

https://chocolatey.org/
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Windows: Bootstrap West and Clone Zephyr Repos

• Open a normal command prompt

• Bootstrap west

> pip3 install west

• Clone the Zephyr git repositories

> cd %userprofile%

> west init --mr v1.14.0 zephyrproject

> cd zephyrproject

> west update

• Install python dependencies

> pip3 install -r zephyr/scripts/requirements.txt
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Windows: Install Toolchain and Flash/Debug Tools

• Install GNU Arm Embedded toolchain
− Use Windows ZIP instead of Windows Installer. This will allow you to define an installation path 

without spaces

− Skip this step if you already have MCUXpresso IDE installed

• Install J-Link flash/debug tools with Windows installer
− Required for i.MX RT and LPC boards, optional for Kinetis boards

− Skip this step if you already have MCUXpresso IDE installed

• Create zephyrrc.cmd file in %userprofile% directory
set ZEPHYR_TOOLCHAIN_VARIANT=gnuarmemb

set GNUARMEMB_TOOLCHAIN_PATH=C:\nxp\MCUXpressoIDE_10.3.1_2233\ide\tools

set PATH=%PATH%;C:\Program Files (x86)\SEGGER\JLink_V642b

https://developer.arm.com/open-source/gnu-toolchain/gnu-rm
https://www.segger.com/downloads/jlink/JLink_Windows.exe
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Install Eclipse IDE Plugins

• Install Eclipse IDE for C/C++ Developers

− Skip this step if you already have MCUXpresso IDE 

installed

• Install GNU MCU Eclipse plug-ins

− From the Help menu, select Eclipse Marketplace

− Search for “gnu mcu eclipse” and click Install

https://www.eclipse.org/downloads/packages/eclipse-ide-cc-developers/oxygen2
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Hands-On Exercises
The Fun Part!
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Hands-On Overview

• Exercise #1: Blinky
− Build and flash a simple application

− Examine application source code and build artifacts

• Exercise #2: Eclipse IDE Debugging
− Generate and import an Eclipse IDE project

− Create and launch a debug configuration

• Exercise #3: Display and Graphics with LittlevGL Integration
− Build and flash an LCD application

• Exercise #4: Configuration and Memory Footprint
− Examine flash/ram footprint with rom_report and ram_report

− Change the configuration and rebuild
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Exercise #1: Blinky
Build and flash a simple application

Examine application source code and build artifacts
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Build and Flash Blinky
• Open a normal command prompt

• Set up the build environment

> cd %userprofile%\zephyrproject\zephyr

> zephyr-env.cmd

• Build the blinky sample application

> west build -b mimxrt1050_evk -d build\blinky samples\basic\blinky

• Flash it to the board

> west flash –d build\blinky

• See the LED blinking
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Blinky Application Source Code

• samples\basic\blinky\src\main.c

• Same application source code works on many 

different boards, not just i.MX RT1050-EVKB

• Standard GPIO interface APIs

− gpio_pin_configure() and gpio_pin_write()

• Standard LED macros generated from device tree

− LED0_GPIO_CONTROLLER and LED0_GPIO_PIN
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i.MX RT1050-EVK Board Device Tree

• boards\arm\mimxrt1050_evk\mimxrt1050_evk.dts

• Defines board hardware components such as 

LEDs, sensors, and external memories

− LED node defines GPIO instance and pin

− Memory nodes define SDRAM and Hyperflash sizes

− Chosen node selects UART instance for console

• Includes SoC device tree
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i.MX RT1050 SoC Device Tree

• dts\arm\nxp\nxp_rt.dtsi

• Defines SoC peripheral addresses, interrupts, and 

device driver labels

• Clocks properties used by peripheral drivers to 

configure UART, I2C baud rates
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Exercise #2: Eclipse IDE 

Debugging
Generate and import an Eclipse IDE project

Create and launch a debug configuration
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Generate an Eclipse IDE Project

• Open a normal command prompt

• Set up the build environment

> cd %userprofile%\zephyrproject\zephyr

> zephyr-env.cmd

• Move to a directory outside the Zephyr tree. This is required only when generating 
Eclipse projects

> cd %userprofile%

• Generate and build an Eclipse project for the hello_world application

> west build -b mimxrt1050_evk %ZEPHYR_BASE%\samples\hello_world -
- -G"Eclipse CDT4 - Ninja"
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Import the Eclipse IDE Project

• Open MCUXpresso IDE

• From the File menu, select 
Import…

• Select Existing Projects into 
Workspace

• Select Next

• Select Browse and navigate to 
your build directory

• Select Finish

Warning: Do not check Copy 
projects into Workspace
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Create a New Debug Configuration

• From the Run menu, select 

Debug Configurations…

• Select GDB SEGGER J-Link-

Debugging, and click the New

button

• Warning: Do not select GDB 

SEGGER Interface Debugging
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J-Link Debug Configuration: Main

• Select the Main tab and 

configure the following 

settings:

• Project: hello_world@build

• C/C++ Application: 

zephyr/zephyr.elf
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J-Link Debug Configuration: Debugger

• Select the Debugger tab and 
configure the following settings:

• Device name: MCIMXRT1052

• GDB Client Executable name: 
C:\nxp\MCUXpressoIDE_10.3.1_22
33\ide\tools\bin\arm-none-eabi-
gdb.exe

• Uncheck Allocate console for 
semihosting and SWO
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J-Link Debug Configuration: Startup

• Select the Startup tab

• Uncheck Enable

semihosting

• Uncheck Enable SWO
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J-Link Debug Configuration: SVD Path

• Select the SVD Path tab and 
configure the following settings:

• SVD file path: 
C:\Users\NXPTraining\zephyrproj
ect\zephyr\ext\hal\nxp\mcux\devic
es\MIMXRT1052\MIMXRT1052.x
ml

• Select Debug to start the 
debugger!
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Open a Serial Terminal

• From the Window menu, 
select Show View->Terminal

• Select the Terminal tab in the 
bottom third of the window

• Select Open a Terminal

• Enter serial port settings as 
shown (COM number may be 
different)



COMPANY PUBLIC 35

Run the Application

• Select Resume to run the 

application

• See in the terminal:

Hello World! mimxrt1050_evk



COMPANY PUBLIC 36

Exercise #3: Display and Graphics 

with LittlevGL Integration
Build and flash an LCD application
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Build and Flash LittlevGL

• Open a normal command prompt

• Set up the build environment

> cd %userprofile%\zephyrproject\zephyr

> zephyr-env.cmd

• Build the LittlevGL sample application

> west build -b mimxrt1050_evk -d build\lvgl samples\gui\lvgl

• Flash it to the board

> west flash -d build\lvgl

• See “Hello world!” on the LCD
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Exercise #4: Configuration and 

Memory Footprint
Examine flash/ram footprint with rom_report and ram_report

Change the configuration and rebuild
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Examine Memory Footprint

• Open a normal command prompt

• Set up the build environment

> cd %userprofile%\zephyrproject\zephyr

> zephyr-env.cmd

• Move to the LittlevGL sample application build directory

> cd build\lvgl

• Run reports to see flash and ram memory footprints

> ninja rom_report

> ninja ram_report
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Change Configuration and Rebuild
• Open samples\gui\lvgl\prj.conf in a text editor and disable logging

CONFIG_LOG=n

• Open a normal command prompt

• Set up the build environment

> cd %userprofile%\zephyrproject\zephyr

> zephyr-env.cmd

• Rebuild the LittlevGL sample application with the new configuration

> west build -d build\lvgl -c

• Move to the LittlevGL sample application build directory and rerun reports

> cd build\lvgl

> ninja rom_report

> ninja ram_report

CONFIG_LOG ROM (B) RAM (B)

Y 80044 590628

N 72376 588425

Delta 7668 2203
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Backup
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